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NEW QUESTION 1
- (Exam Topic 1)
You need to add controls to the check-in solution for the health and wellness questions. Which form control should you use?

A. Drop down
B. Check box
C. Text input

Answer: A

NEW QUESTION 2
- (Exam Topic 1)
A guest asks about the start time of a specific scheduled event and wants to know what the snow conditions will be like during their stay.
You need to determine how to design the chat solution to answer those questions. What should you do? To answer, select the appropriate options in the answer
area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface Description automatically generated
Box 1: Load the extracted topic into a variable
Power Virtual Agents uses entities to understand and identify a specific type of information from a user's responses. When saving the identified information to a
variable, a variable type will be associated with it. The variable type is analogous with the entity.
In Power Virtual Agents, a topic defines a how a bot conversation plays out.
A topic has trigger phrases – these are phrases, keywords, or questions that a user is likely to type that is related to a specific issue – and conversation nodes –
these are what you use to define how a bot should respond and what it should do.
Box 2: Create a custom entity
The prebuilt entities cover commonly used information types, but on some occasions, such as when building a bot that serves a specific purpose, you'll need to
teach the bot's language understanding model some domain-specific knowledge.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 3
- (Exam Topic 1)
You need to design the resort portal to meet the business requirements. Which data source should you use?

A. Microsoft Excel
B. Azure SQL Database
C. SQL Server
D. Common Data Service

Answer: A

NEW QUESTION 4
- (Exam Topic 1)
You need to design the resort portal’s email registration process. Which solution should you use?

A. Default the invitation code from the email upon logging into the portal
B. Auto-populate the invitation code field on the sign in screen from the email link
C. Embed the invitation code in the email link URL
D. Send the customer their username and temporary password in the email link

Answer: C

Explanation: 
Scenario: Guests must receive a separate email to verify proof of ownership for their registration. Note: You can setup redeem an invitation code for power apps
portal.

Passing Certification Exams Made Easy visit - https://www.2PassEasy.com



Welcome to download the Newest 2passeasy PL-200 dumps
https://www.2passeasy.com/dumps/PL-200/ (211 New Questions)

Reference:
https://carldesouza.com/how-to-setup-redeem-an-invitation-code-for-power-apps-portal/

NEW QUESTION 5
- (Exam Topic 2)
You need to implement the requirement for the VP of sales. What should you do?

A. Use a test account with a base security role with QV security added.
B. Add the System Administrator security role to your user account.
C. Use a test account with only QV security added.
D. Add QV security to your user account.

Answer: A

Explanation: 
A VP of sales requires a test environment to demonstrate to potential clients the security policies that are included in their initial offering.
Currently, testing the new QV functionality outside the development environment is not possible due to corporate security policies requiring the same security role
across all environments.
Note: One of the security best practices in Dynamics 365 is to use the base security role as a baseline and apply that role to all Users. The base security role will
include all the common/basic permissions that are required to have access to the system.
To set up the base security role for the first time

 create a new empty security role.

 add the minimum privileges required to access the system.

 add the privileges required for the basic functionalities.

 test the role with the test user account.

 add the permissions to the entities that all users can access (e.g. reference data).
Reference: https://linnzawwin.blogspot.com/2020/07/minimum-privileges-required-to-log-in.html 

NEW QUESTION 6
- (Exam Topic 2)
You create a desktop flow to interact with a certification authority’s website. You need to get data in and out of the desktop flow.
How should you set up the input and output parameters? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Connect by using the Dataverse connector from the desktop flow and retrieve the qualification data. All information sent by clients for services is stored in
Microsoft Dataverse with a model-driven app as the
interface.
Qualification verification
The qualification table contains details about an individual school degree, professional qualifications, and other qualifications that must be verified.
A service request can have one or more Qualification records associated with it.
Record status is pending verification until the initial team member finishes, at which point the member changes the status to Complete.
When all qualification records related to a service request are verified either by manual or automated processes, the results are made available to ADatum
Corporation’s client.
In the rare event that results are questioned, a new service request is created and verified independently of the previous work that took place.
Box 2: Send data from the desktop flow to a cloud flow to update the qualification record. To complete a service request, users perform the following actions:
Send a templated email by using Microsoft Outlook to the client after all qualifications for a service request are checked.
Change the service request status to Completed. Currently, service requests do not indicate when all Qualification records are addressed.

NEW QUESTION 7
- (Exam Topic 2)
You need to capture the Date Completed value from the website using a desktop flow. Which method should you use?

A. Use optical character recognition (OCR) on the screen to locate and extract the value.
B. Display an input dialog and prompt the user to enter the value.
C. Extract the value from the window the browser is using.
D. Retrieve the value from the HTML element in the webpage.

Answer: C
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Explanation: 
Record the name of the QV team member who performed the work and the date completed.

NEW QUESTION 8
- (Exam Topic 2)
You need to configure a Power Automate flow to send the email with the results to the client. What should you use? To answer, select the appropriate options in
the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Apply to each
You can use the Apply to each action to process a list of items periodically. Box 2: Do until
The Do Until control in Power Automate is a loop that repeatedly forces an action until a certain condition becomes true.
Reference: https://docs.microsoft.com/en-us/power-automate/apply-to-each https://blog.enterprisedna.co/do-until-loop-control-in-power-automate/

NEW QUESTION 9
- (Exam Topic 3)
You are a Dynamics 365 Customer Service system administrator.
Your organization does not permit the use of custom code for solutions. You need to create a view that can be viewed by all users in an organization. Where
should you create the view?

A. Microsoft Excel template
B. Entities component of a solution
C. Microsoft Virtual Studio
D. Templates area

Answer: B

Explanation: 
Entity: Refers to a table in Dataverse. Table and entity are often used interchangeably for data access. Edit public views through tables

Expand Data, select Tables, select the table you want, and then select the Views area.

 On the toolbar, select Add view. Add view to table

 On the Create a view dialog, enter a name and, optionally, a description, and then select Create. Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-edit-views-app-designer

NEW QUESTION 10
- (Exam Topic 3)
You create a parent entity and a child entity. The parent entity has a 1:N relationship with the child entity.
You need to ensure that when the owner changes on the parent record that all child records are assigned to the new owner.
You need to configure the relationship behavior type. What should you use?

A. Parental
B. Referential, Restrict Delete
C. Referential
D. Restrict

Answer: A

Explanation: 
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/create-and-edit-1n-relationship A parental table relationship is any 1:N table
relationship where one of the cascading options in the Parental column of the following table is true.
Graphical user interface, application Description automatically generated
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Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/create-edit-entity-relationships

NEW QUESTION 10
- (Exam Topic 3)
You plan to create classic workflows for process automation on the Account table. The process automation has the following requirements:
• If the Account Name column changes, a custom column named Previous Name must be updated with the original value.
• If the Credit Limit column changes, an email must be sent to the record owner with the new value.
• Asynchronous processes must be used whenever possible. You need to implement the process automation.
What is the minimum number of workflows you should use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 13
- (Exam Topic 3)
You are creating tables for use with Microsoft Power components.
The display names of the tables must not be changed when the solution is promoted to the user acceptance testing environment.
You need to apply this restriction to the solution, Where should you make the changes?
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A. Power Apps
B. Default solution
C. Segmented solution
D. Unmanaged solution
E. Managed solution

Answer: C

NEW QUESTION 16
- (Exam Topic 3)
You plan to create a dataflow to import data into Microsoft Dataverse by using Power Query. The dataflow has the following requirements:
• A table of aggregated data must be created in dataflow storage.
• A unique identifier must be created for the table.
You need to configure the dataflow.
Which solutions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection Is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 18
- (Exam Topic 3)
You plan to implement Microsoft Dataverse.
You must track changes for two columns in the Account table. You must maintain a historical log of changes for the two columns and track only what is necessary.
You configure the appropriate organization settings.
You need to configure the system to track changes for the two columns.
Which two actions should you perform? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Enable auditing for the Account table.
B. Enable auditing for the two specific columns.
C. Enable change tracking for the Account table.
D. Enable change tracking for the two specific columns.

Answer: AB

Explanation: 
By setting the IsAuditEnabled property of a table’s definition and the IsAuditEnabled property of each desired column’s definition to true, data changes to records
of those tables can be logged by the platform.
Note: There are three levels where auditing can be configured: organization, table, and column. The organization level is the highest level, followed by the table
level, and finally the column level. For column auditing to take place, auditing must be enabled at the column, table, and organization levels. For table auditing to
take place, auditing must be enabled at the table and organization levels.
Reference:
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/configure-entities-attributes-auditing

NEW QUESTION 23
- (Exam Topic 3)
You create a report by using Power BI Desktop and a Power BI dataset that is connected to Azure SQL Database.
Multiple groups of employees will use the report.
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You need to ensure that each group of employees can see only data that pertains to their group. What should you do?

A. Create and assign file security profiles.
B. Create and assign Common Data Service security roles.
C. Create and assign roles by using row-level security.

Answer: C

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards

NEW QUESTION 25
- (Exam Topic 3)
A company deploys several model-driven apps. The company uses shared devices in their warehouse. The devices are always powered on. Users log on to the
devices and then launch the apps to perform actions.
Unauthorized users recently uploaded several files after another user failed to log out of a device. The company needs to prevent these incidents from occurring in
the future.
You need to configure the solution to prevent the reported security incidents. What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Set a timeout in the Power Platform admin center.
To enforce users to reauthenticate after a pre-determined period of time, admins can set a session timeout for their individual environments. Users can only remain
signed in the application for the duration of session. The application signs out the user when the session expires. Users need to sign in with their credentials to
return to customer engagement apps.
Note: Configure session timeout

 In the Power Platform admin center, select an environment.

 Select Settings > Product > Privacy + Security.

 Set Session Expiration and Inactivity timeout. These settings apply to all users.
Incorrect:
Configure inactivity timeout

 In the Power Platform admin center, select an environment.

 Select Settings > Product > Privacy + Security.

 Set Session Expiration and Inactivity timeout. These settings apply to all users. Box 2: Enter the restricted file types in the SharePoint admin center.
To block uploading of specific file types

 Go to the Settings page of the new SharePoint admin center,

 Select Sync.
Graphical user interface, text, application Description automatically generated
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 Select the Block upload of specific file types check box.

 Enter the file name extensions you want to block, for example: exe or mp3.

 Select Save.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/user-session-management https://docs.microsoft.com/en-us/onedrive/block-file-types

NEW QUESTION 28
- (Exam Topic 3)
You are modifying a model-driven app. You set up a customer table in Microsoft Power Platform to retrieve user data. You set up a form with the following columns
for users to enter their data. The form includes the following columns:

The form must do the following:
• The Country/region column must automatically populate with US when English is chosen as a language. If the user selects Other for this column, the column
must remain blank so that user can enter a value.
• The Passport expiration date column must appear only if the user selects Yes in the Passport ownership column.
You need to configure the app with the least amount of effort.
What should you configure? To answer, drag the appropriate solution component to the correct requirements. Each solution component may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface Description automatically generated with low confidence

NEW QUESTION 33
- (Exam Topic 3)
You create a new Power Virtual Agents chatbot for an organization. Testing and production deployment of the chatbot are not complete. You need to ensure that
appropriate users can access the chatbot.
Which methods should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, application Description automatically generated
Box 1: Use the demo website
When publishing the bot to the web, you can publish to a prebuilt demo website (which you can use to share the bot with your teammates and stakeholders) and to
your own live website.
Box 2: Share the chatbot to a security group containing all users.
A license for each user, also known as a "per user license" (or "Power Virtual Agent User License" as referred
to on the Microsoft 365 admin center), should be assigned to individual users who need access to create and manage chatbots.
To simplify user license management, you can assign licenses to an Azure Active Directory (Azure AD) security group.
Box 3: Embed the chatbot code in an IFRame on your copany's public website
You can add your bot to a live website as an IFrame. Your live website can be a customer-facing external website or an internal site, like a SharePoint or Yammer
site.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/publication-connect-bot-to-web-channels https://docs.microsoft.com/en-us/power-virtual-
agents/requirements-licensing

NEW QUESTION 35
- (Exam Topic 3)
A company uses a canvas app.
Supervisors must approve transactions when a user from the sales department enters a revenue amount that is over $1 million.
You need to configure an approval process without using code. What should you create?

A. Column Expression
B. Power Automate cloud flow
C. Azure Service Bus service
D. Power Apps component framework (PCF) control

Answer: B

NEW QUESTION 39
- (Exam Topic 3)
A company plans to automate the following manual processes by using Power Automate. You need to identify UI flow types for the two business processes.

Which desktop flow type should you use? To answer, drag the appropriate desktop flow types to the correct business processes. Each desktop flow type may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, application Description automatically generated

NEW QUESTION 41
- (Exam Topic 3)
You deploy a Power Vitlu.il Agents chatoot that integrates with Dynamics 365 Omnichannel for Customer Service.
You observe that the chatbot is not able to recognize the questions asked by use's.
You need to ensure that the chatbot can respond to unrecognized questions. The solution must minimize administrative effort.
What should you do?

A. Add a fallback topic
B. Create new topics.
C. Create an entity.
D. Modify the Escalate system topic.

Answer: A

NEW QUESTION 46
- (Exam Topic 3)
A company is building a Power Virtual Agents chatbot.
Users in the accounting department require access to collaborate with the building of the bot. Users in the sales department require access to only chat with the
bot.
You need to configure the bot.
Which sharing options should you use? To answer, drag the appropriate sharing options to the correct requirements. Each sharing option may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 49
- (Exam Topic 3)
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You need to design the FAQ solution to handle unknown responses.
Which component should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-hand-off

NEW QUESTION 52
- (Exam Topic 3)
You create a new independent software vendor (ISV) solution for a Power Apps app.
The Power Apps solution will be imported into multiple customer environments. The environments will have a large variety of solutions and publishers.
You need to avoid naming conflicts during solution import.
Which element should you configure?

A. Package type
B. Configuration page
C. Marketplace
D. Prefix
E. Version

Answer: D

Explanation: 
A solution publisher includes a prefix. The publisher prefix is a mechanism to help avoid naming collisions. This allows for solutions from different publishers to be
installed in an environment with few conflicts. For example, the Contoso solution displayed here includes a solution publisher prefix of contoso.
Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm

NEW QUESTION 53
- (Exam Topic 3)
You need to build a Power Bl dashboard for sales managers to track opportunities.
When a new sale closes that is greater than S1 million, a notification must pop up and an email must be sent to the leadership team.
You need to ensure the email is sent without editing the Microsoft Dataverse.
Which two elements should you configure? Each correct answer is part of the solution. NOTE: Each correct selection is worth one point.

A. alerts in Power Bl
B. a calculated column in the Dataverse
C. a custom connector
D. a paginated report to save to Microsoft OneDrive
E. a Power Automate flow

Answer: AE

Explanation: 
In order to build a Power Bl dashboard for sales managers to track opportunities and send notifications and emails when a new sale closes that is greater than S1
million, you should configure:
* A. alerts in Power Bl: You can set up alerts in Power Bl that will trigger when a specific condition is met. For example, you can set an alert to trigger when the
value of a specific field in the "Opportunities" table exceeds $1 million.
* E. a Power Automate flow: To send an email to the leadership team when an alert is triggered, you can create a Power Automate flow that is triggered by the
Power Bl alert. The flow can then use the "Send an email" action to send an email to the leadership team with the necessary information about the sale that
exceeded $1 million.
References:

 https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-alerts

 https://docs.microsoft.com/en-us/power-platform/admin/alerts-overview

NEW QUESTION 56
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- (Exam Topic 3)
You are creating a business rule to implement new business logic.
You must apply the business logic to a canvas app that has a single screen named Screen1. You need to configure the scope for the business rule.
Which scope should you use?

A. All Forms
B. Entity
C. Screen1
D. Global

Answer: B

Explanation: 
Note: Some terminology has changed. Entity is now Table. If you're building a Canvas app, you must use table (entity) as the scope.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

NEW QUESTION 59
- (Exam Topic 3)
A company uses a model driven app.
The company needs to automatically update the Status column in real time. You need to configure this feature.
Solution: Create a workflow that has a Change Status step. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 64
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

 0 - 17

 18 - 25

 26 - 35

 36 - 55

 55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Create a custom Age group entity and
synonyms for each individual age in the corresponding item.
Use Age group for Identify in the question.
Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 69
- (Exam Topic 3)
You attempt to deactivate several currencies in a Microsoft Dataverse environment. You are not able to deactivate one of the currencies.
You need to determine why you cannot deactivate the currency. What is the reason?

A. You are not the currency record owner.
B. The currency is used by an active business process.
C. The currency is the base currency.
D. The currency is used by another record.

Answer: C

Explanation: 
Reference:
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/org-service/web-service-error-codes https://docs.microsoft.com/en-us/power-
platform/admin/manage-transactions-with-multiple-currencies

NEW QUESTION 74
- (Exam Topic 3)
A company has a portal. Users sign into the portal by using a social media account.
The company wants to replace the existing portal with a Power Apps portal. users must sign up for access to the portal by using a Microsoft account and a unique
invitation code that will be provided to the users.
You need to configure authentication for the home page.
Which values should you use? To answer, drag the appropriate values to the appropriate authentication settings. Each value may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
NO NO

NEW QUESTION 76
- (Exam Topic 3)
The app needs to store temporary data
• Each screen must maintain a separate copy of data and pass the data to another screen.
• The app must be able to update separate rows of a table independently. You need to configure variables for the data.
Which variable types should you use? To answer, drag the appropriate variable types to the correct requirements. Each variable type may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated with medium confidence

NEW QUESTION 81
- (Exam Topic 3)
A bank uses Power BI visualizations to help determine whether they should loan money to a customer. The bank has three different visuals that are part of a
Power BI report. The bank uses a set of four risk variables that indicate whether the customer is creditworthy.
You must create a mechanism so that bank employees can change the values of the four risk variables. Changes to the value of any variable must cause the three
visualizations to update.
You need to create the solution.
Which action should you perform? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Embed a Power BI report in a model-driven app
You can embed a Power BI report in a model-driven app main form. Box 2: Use the Power BI service.
The Power BI cloud service works with Microsoft Dataverse apps to provide a self-service analytics solution. Power BI automatically refreshes the app's data
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displayed. With Power BI Desktop or Microsoft Excel, Power Query for authoring reports and Power BI for sharing dashboards and refreshing data from model-
driven apps,
your users have a powerful way to work with your app's data.
Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/embed-powerbi-report-in-system-form
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/use-power-bi

NEW QUESTION 83
- (Exam Topic 3)
On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Categorized Search to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead use Relevance Search.
Note: Relevance Search finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming,"
or "streamed."
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-releva

NEW QUESTION 88
- (Exam Topic 3)
You are a Dynamics 365 administrator. You create a new app.
You need to create the site map for the app.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 90
- (Exam Topic 3)
A company is creating a canvas app and a model-driven app to manage their customer accounts.
The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value.
The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only.
You need to configure the scope for the business rules.
Which scope should you use? To answer, drag the appropriate scopes to the correct business rules. Each scope may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Table
The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value.
Scope the business rule to Entity (Table). Box 2: Specific form
The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only.
For Model
The scope of the business rule determines which forms the business rule will be applied. You set the scope, according to the following:
If you select this item... The scope is set to...
Entity- The table and all forms for the table All Forms- All forms for the table
Specific form (account Main Form, for example) - Just that form
Reference: https://debajmecrm.com/business-rules-in-powerapps-canvas-apps/
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-business-rules-recommendations

NEW QUESTION 93
- (Exam Topic 3)
You plan to create a canvas app.
The app must meet the following requirements:
• Send an email after a record is saved.
• Display the expiration column on a form if the creation date of the record is older than 90 days. You need to configure the app.
Which features should you use? To answer, select the appropriate options in the answer area.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 97
- (Exam Topic 3)
You have a canvas app.
The canvas app must store data in a variable that is available only to the current screen. You need to create the variable.
Which two functions should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. Navigate
B. UpdateContext
C. Set
D. Collect
E. SaveData

Answer: BC

Explanation: 
* B. UpdateContext function can be used to create a variable that is only available to the current screen. This function takes in an object that defines the variable
and its initial value, and updates the context of the current screen with that variable. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-updatecontext
* C. Set function can be used to assign a value to a variable. The Set function sets a variable to a specified value, which is useful when you need to update the
value of a variable. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-set

NEW QUESTION 102
- (Exam Topic 3)
You are implementing a model-driven app to support a new line of business. There are several places where automated business logic must be applied. You need
to determine how to apply the business logic.
Which method should you use? To answer, drag the appropriate methods to the appropriate business logic statements. Each method may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Business rule
By combining conditions and actions, you can do any of the following with business rules:

 NSE5_FSM-5.2 Set column values

 Clear column values

 Set column requirement levels

 Show or hide columns

 Enable or disable columns

 Validate data and show error messages

 Create business recommendations based on business intelligence. Box 2: Real-time workflow
Real-time workflows:
Graphical user interface, text, application, email Description automatically generated

Box 3: Power Automate instant flow
Instant Flows don’t have a trigger in the same way as the Automated flow. Instead, they are triggered manually or on-demand, such as a user clicking a Flow
button in the mobile app.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-business-rules-recommendations-a https://docs.microsoft.com/en-
us/powerapps/maker/data-platform/configure-workflow-steps https://carldesouza.com/difference-between-instant-automated-and-scheduled-flows-in-power-
automate-and-ho

NEW QUESTION 103
- (Exam Topic 3)
You are a Dynamics 365 for Customer Service administrator.
You must create a form for team members to use. The form must provide the ability to:

 Lock a field on a form.

 Trigger business logic based on a field value.
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 Use existing business information to enhance data entry.
You need to implement business rule components to create the form.
Which components should you use? To answer, drag the appropriate components to the correct requirements. Each component may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

 Action

 Condition

 Recommendation

NEW QUESTION 108
- (Exam Topic 3)
A customer uses Power Apps to view and maintain their contacts that are stored in Microsoft Dataverse. Several columns must be configured to ensure the
security settings for sales associates are view only. You need to configure the access restrictions.
Which component for field-level security should you use? TO answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated

NEW QUESTION 112
- (Exam Topic 3)
You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.
The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable OneNote integration.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 113
- (Exam Topic 3)
A company is configuring a Power Apps portal using Microsoft Dataverse. The company requires the following:

Passing Certification Exams Made Easy visit - https://www.2PassEasy.com



Welcome to download the Newest 2passeasy PL-200 dumps
https://www.2passeasy.com/dumps/PL-200/ (211 New Questions)

 Only authenticated users must be able to sign into the portal.

 Authenticated users must have varying degrees of access to the different parts of the portal.

 Users must enter one of several external identities when creating an account during the open registration process.
You need to configure user authentication and permissions.
Which component should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Contact table record
In Power Apps portals, each authenticated portal user is associated with a contact record in Microsoft Dataverse.
Box 2: Web roles
Portal users must be assigned to web roles to gain permissions beyond unauthenticated users. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-portal-authentication

NEW QUESTION 115
- (Exam Topic 3)
A Company plans to send escalation emails to all customers with overdue invoices. You are creating a Microsoft Power Automate flow to determine whether to
send an escalation email.
The system must send an alert for all invoices that are seven days or more overdue. You need to configure the flow.
Which expression should you use?

A. Option A
B. Option B
C. Option C

Answer: C

Explanation: 
Example: equals(triggerOutputs()?[‘body/PDFStatus/Value’],’Ready to Generate’) Reference:
https://evolvous.com/microsoft-power-automate-trigger-condition/

NEW QUESTION 118
- (Exam Topic 3)
A company uses model-driven apps.
Users in the sales department enter the first name, last name, and phone number of customers in the app. The users request a single screen in the app to enter
the customer data.
You need to configure the app. What should you do?

A. Create a canvas app.
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B. Modify the site map.
C. Create a Power Automate flow.
D. Use a Power Virtual Agents app.

Answer: B

Explanation: 
To configure a model-driven app in order to provide a single screen for the sales department users to enter the customer data, you should modify the site map of
the app. A site map is a hierarchical representation of the different areas and functionality of the app, and it can be modified to create a new screen or view that
combines the necessary fields for the customer data entry.
Once the site map is modified, you can add the necessary fields (first name, last name, and phone number) to the new screen or view, and make it accessible to
the sales department users.
References:

 https://docs.microsoft.com/en-us/power-platform/admin/model-driven-apps-overview

 https://docs.microsoft.com/en-us/power-platform/admin/modify-site-map

NEW QUESTION 120
- (Exam Topic 3)
A company creates a model-driven app.
Users require access to a Power Bl report that is embedded in the app. You need to configure the app.
Where should you add the report?

A. XML report
B. Dashboard
C. Business rule
D. Power Automate cloud flow

Answer: B

Explanation: 
To add a Power BI report to a model-driven app, you should add it to a dashboard. Dashboards in
model-driven apps provide a way to organize and display information, such as charts, tables, and reports. You can add a Power BI report to a dashboard by
creating a new dashboard and then adding a Power BI report component to it. This component allows you to specify the report you want to add and configure its
properties, such as size and layout. Users will then have access to the embedded report when they view the dashboard in the app. Reference:
https://docs.microsoft.com/en-us/power-platform/admin/create-model-driven-app-dashboards

NEW QUESTION 123
- (Exam Topic 3)
A company plans to create two Microsoft Power Platform applications.
One of the applications requires a custom control layout without using code. The other application will be used primarily by external users.
You need to create the applications.
Which application types should you use? To answer, drag the appropriate application types to the correct requirements. Each application type may be used once,
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 128
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- (Exam Topic 3)
A company uses Power Apps with Microsoft Dataverse.
The company enables auditing on the Dataverse database. The company tenant reaches the maximum storage capacity.
You need to delete some auditing data.
Which three deletion options should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. by table
B. by record
C. between two specified dates
D. by column
E. older than a specified date

Answer: ACE

Explanation: 
* A. Deleting by table allows you to select specific tables in the Dataverse database for which you want to delete the auditing data. This can be done by going to
the Power Apps portal, navigating to the Data tab, and selecting the table for which you want to delete the auditing data. You can then select the specific auditing
data you want to delete and click the "Delete" button. This is useful if you want to only delete auditing data for specific tables and not for the entire database.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs
* C. Deleting between two specified dates allows you to select a range of dates within which the auditing data will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Between two dates"
option. Then you can specify the start and end date for which you want to delete the auditing data. This is useful if you want to delete auditing data for a specific
time period and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs
* E. Deleting older than a specified date allows you to select a specific date, and any data older than that date will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Older than a
specified date" option. Then you can specify the date for which you want to delete the auditing data. This is useful if you want to delete auditing data that is older
than a certain date and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-
audit-logs
It's always good to have a backup of Data before deletion and also check the retention period of the data you want to delete.

NEW QUESTION 130
- (Exam Topic 3)
You use Power BI Desktop to configure Power BI reports.
You need to create a canvas app that displays user account information and include the app in a Power BI
report.
Which three actions should you perform? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. From the Power Apps Insert menu, add a Power BI tile
B. From the Power BI Desktop menu, insert a Power Apps visual and include the required fields in the Power Apps data
C. Publish the report to the Power BI service
D. Connect to Common Data Service from Power BI Desktop

Answer: BCD

Explanation: 
Step 1 (B): Here’s how we embed PowerApps into a Power BI report:

 Download and login to the Power BI desktop application

 Click on (…) and select “Import from the marketplace.”
Step 2: Open Power BI desktop and use “Get data” to connect with the Common Data Service data source. Step 3: Publish the report to Power BI service.
Reference:
https://purple.telstra.com/blog/powerbi-integration-with-powerapps

NEW QUESTION 131
- (Exam Topic 3)
You are a Dynamics 365 Customer Service administrator.
You need to configure the following automation for the sales team:
* Send an email when the status changes on an Opportunity.
* Text the sales manager when an Opportunity is created.
* Create a Wunderlist task when an Opportunity is open for 30 days.
Which tool should you use for each requirement? To answer, select the appropriate options in the answer area. NOTE Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 132
- (Exam Topic 3)
A company uses Microsoft Teams. You plan to create a Power Apps app for Microsoft Teams. You need to determine the environment that will used by the app.
Which environment will the app use?

A. An existing Dataverse environment that you select.
B. An existing Dataverse for Teams environment that you select.
C. A Dataverse environment that is automatically created for the team.
D. A Dataverse for Teams environment that is automatically created for the team.

Answer: D

Explanation: 
The Dataverse for Teams environment is automatically created for the selected team when you create an app or bot in Microsoft Teams for the first time or install a
Power Apps app from the app catalog for the first time. The Dataverse for Teams environment is used to store, manage, and share team-specific data, apps, and
flows. Each team can have one environment, and all data, apps, bots, and flows created with the Power Apps app inside a team are available from that team's
Dataverse for Teams database.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/about-teams-environment

NEW QUESTION 135
- (Exam Topic 3)
A company creates a canvas app.
The app requires users to enter their social security number. The app should only display the last four digits when the user tabs to a different column.
You need to configure the app. Which option should you use?

A. Power Fx
B. Business rule
C. Business process flow
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D. Power Bl DAX

Answer: A

NEW QUESTION 137
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history. Solution: Change Elizabeth’s username in the user record for the app.
Does the solution meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 142
- (Exam Topic 3)
A company uses Dataverse to store the names of contacts. The company uses a shared Microsoft Excel file to collect the data. The company requires that the
contacts be added to Dataverse automatically every day
You need to identify which tools are required to create and perform the import. What should you use? To answer, select the appropriate options in the answer
area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 145
- (Exam Topic 3)
You are using power Automate to create a list of customers from a Microsoft Excel file, The list must contain customers who meet one of the following criteria:

 Sales of less than $500,000.

 Customers who are on credit hold.
You need to create a condition to filter the list Of customers.
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How should you complete the filter condition? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, application, Word Description automatically generated
Box 1: or
Or: Takes two arguments and returns true if either argument is true. Box 2: equals(item()?['credithold'],'true')
Equals: Returns true if two values are equal.
For example, if parameter1 is someValue, this expression returns true: equals(parameters('parameter1'), 'someValue')
Reference:
https://docs.microsoft.com/en-us/power-automate/use-expressions-in-conditions

NEW QUESTION 147
- (Exam Topic 3)
You are designing a canvas app that connects to Common Data Service.
You need to configure the app to meet the requirements and ensure that the canvas app is available offline. What should you implement? To answer, select the
appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/offline-apps

NEW QUESTION 150
- (Exam Topic 3)
A company uses a Microsoft Power Platform environment
The company plans to implement a Power Apps app. The application must meet the following requirements:
• Audit all user activity and only retain the audit logs for one year.
• Annually remove products that were created over a year ago. You need to configure the automated processes.
What should you configure? To answer, drag the appropriate configurations to the correct requirements. Each configuration may be used once, more than once, or
not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 154
- (Exam Topic 3)
You plan to create a Power Virtual Agents bot. The bot has the following requirements:
• Ensure that user responses are available to any topic.
• Recognize a list of words from spoken language of users. You need to configure the bot.
Which features should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 156
- (Exam Topic 3)
You are using Power BI to build a dashboard for a company.
You must make the dashboard available to a specific set of users, including employees and five external users. The number of employees that require access to
the dashboard varies, but usually less than 100. Employees and external users must not be permitted to share the dashboard with other users.
You need to share the dashboard with the employees and external users.
Which three actions should you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Create a dynamic distribution lis
B. Add all users to the distribution group and use the list to share the dashboard.
C. Sign into the Power BI servic
D. Open the dashboard and select Share.
E. Enter the individual email address of internal and external users.
F. Sign into Power BI Deskto
G. Open the dashboard and select Share.
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H. Clear the Allow recipients to share your dashboard (or report) option.
I. Create a distribution grou
J. Add all users to the distribution group and use the list to share the dashboard.

Answer: BEF

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards

NEW QUESTION 158
- (Exam Topic 3)
You plan on implementing complex business logic in Microsoft Dataverse tables by using Power Automate flows.
You realize that the functionality required to implement the business logic is not available in a Power Automate flow.
The new business logic must work in multiple Dataverse tables. In addition, the operation must return a value after it finishes and must be able to run from an
existing Dataverse action.
You need to recommend the method to implement the missing logic. What should you recommend?

A. Scheduled workflow
B. Bound action
C. Custom API
D. Unbound action

Answer: D

Explanation: 
https://docs.microsoft.com/en-us/power-automate/dataverse/bound-unbound https://docs.microsoft.com/en-us/power-apps/developer/data-platform/custom-api

NEW QUESTION 161
- (Exam Topic 3)
You are designing a Power Virtual Agents chatbot.
The chatbot must be able to maintain customer information if the conversation topic changes during a dialog.
You need to configure variables to store customer name and email address. Which type of variable should you create?

A. session
B. topic
C. bot
D. slot

Answer: C

Explanation: 
By default, a variable's value can only be used in the topic where this variable gets created. However, you might want the bot to use the same value across topics.
This means the bot can remember the necessary context when a conversation spans multiple topics. In some systems, these types of variables are known as
global variables. In Power Virtual Agents, these variables are called bot variables, because they apply across the entire bot.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables-bot

NEW QUESTION 166
- (Exam Topic 3)
A company uses a model-driven app. The app uses a workflow to send email. Emails are sent to new customers that enter an email address for the first time in the
app.
Customers report that they do not receive an email after entering an email address. You need to troubleshoot the issue.
In which order should you perform the actions? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct
order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 171
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- (Exam Topic 3)
You create workflows to automate business processes.
You need to create a workflow that automatically sends emails based on a mail merge template. The workflow must contain the following configurations:

 Run immediately.

 Validate when a condition is met.

 Perform an action when a condition is met.
To answer, select the appropriate configuration in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated

NEW QUESTION 175
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history.
Solution: From Dynamics 365 Settings, select Email Configuration. In the active mailbox for the user, update the name.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Change the user name, not the email configuration. Change a user's email address
You must be a global admin to complete these steps.

 In the admin center, go to the Users > Active users page.

 Select the user's name, and then on the Account tab select Manage username.

 In the first box, type the first part of the new email address. If you added your own domain to Microsoft 365, choose the domain for the new email alias by using
the drop-down list. Learn how to add a domain.

 Select Save changes. Reference:
https://docs.microsoft.com/en-us/microsoft-365/admin/add-users/change-a-user-name-and-email-address

NEW QUESTION 179
- (Exam Topic 3)
You are creating a canvas app.
A user will click a button on each screen of a Power Apps app to proceed to the next screen. You need to implement an action that selects the next screen that the
user sees.
Which event should you handle?
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A. OnLoad
B. OnCheck
C. ScreenTransition
D. OnSelect

Answer: D

Explanation: 
 Add navigation
* 1. With the Source screen selected, open the Insert tab, select Icons, and then select Next arrow.
* 2. With the arrow still selected, select the Action tab, and then select Navigate.
* 3. The OnSelect property for the arrow is automatically set to a Navigate function.

* 4. When a user selects the arrow, the Target screen fades in.
* 5. On the Target screen, add a Back arrow, and set its OnSelect property to this formula:
* 6. Navigate(Source, ScreenTransition.Fade)
* 7. While holding down the Alt key, toggle between screens by selecting the arrow on each screen. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables

NEW QUESTION 180
- (Exam Topic 3)
You ate a Dynamics 365 Customer Engagement administrator. You create workflows to automate business processes. You need to configure a workflow to meet
the following requirements:
• Be triggered when a condition is met.
• Run immediately.
• Perform an action when a condition is met.
How should you configure the workflow? To answer, select the appropriate configuration in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
1) Be triggered when a condition is met - Subject contains data
2) Run Immediately - Configure the workflow to run now
3) Perform an action when a condition is met - send an email

NEW QUESTION 182
- (Exam Topic 3)
A user has access to an existing Common Data Service database.
You need to ensure that the user can create canvas apps that consume data from Common Data Service. You must not grant permissions that are not required.
Which out-of-the-box security role should you assign to the user?

A. Environment Admin
B. System Customizer
C. Common Data Service User
D. Environment Maker

Answer: D

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/database-security#predefined-security-roles https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/data-platform-create-app

NEW QUESTION 184
- (Exam Topic 3)
You have a classic workflow. The workflow updates a custom column on a record when an account record is created. The workflow must update the custom
column based on the following conditions:
• Update the custom column value using the Account Number.
• If the Account Number column is blank, update the custom column value using the Ticker Symbol.
• If the Ticker Symbol column is blank, update the custom column value to N/A
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You need to configure the custom column value by using the update record step. What should you do?

A. Add the two columns with the default value by using the Forms Assistant.
B. Add an expression that evaluates the two column values and uses the first populated value or else the default value.
C. Add check conditions to determine if the two columns contain data.
D. Add a formula that evaluates the two column values and uses the first populated value or else the default value

Answer: A

NEW QUESTION 186
- (Exam Topic 3)
On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Quick Find search on the Notes list to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead use Relevance Search.
Note: Relevance Search finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming,"
or "streamed."
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-releva

NEW QUESTION 190
- (Exam Topic 3)
A company uses a model-driven app. The app uses a Power Virtual Agents chatbot.
The company has two locations in different countries/regions with separate environments for each location. Each location has a development environment, a
testing environment, and a production environment. The company uses the Application Lifecycle Management (ALM) process for the environments.
You need to create the different Power Virtual Agents bot environments. How many Power Virtual Agents bot environments are required?

A. 1
B. 2
C. 3
D. 6

Answer: D

Explanation: 
When a company uses a model-driven app that incorporates a Power Virtual Agents chatbot, and has multiple locations with different environments for each
location, it is necessary to create separate Power Virtual Agents bot environments for each location.
For each location, 3 different environments are required: development, testing, and production. This is in line with the Application Lifecycle Management (ALM)
process that the company uses.
In total, 6 Power Virtual Agents bot environments are required: 2 locations x 3 environments per location = 6. It's worth mentioning that Power Virtual Agents allows
to export and import the bot, so once you configure the bot in one environment, you can import the bot to the other environments, this way you don't need to start
from scratch.
References:

 https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/bot-lifecycle

 https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/export-import

NEW QUESTION 195
- (Exam Topic 3)
You are creating a new business process flow to qualify leads.
You create an action. The action is not available inside the Action Step. You need to make the action available to the Action Step.
Which two steps must you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Activate the action.
B. Select Run as an on-demand process
C. Add at least one step to the action.
D. Ensure that the entity for the action matches the corresponding entity for the business process flow stage.

Answer: CD

Explanation: 
Reference:
https://docs.microsoft.com/en-us/business-applications-release-notes/april18/microsoft-flow/add-action-business

NEW QUESTION 197
- (Exam Topic 3)
You plan to create a Power Bi dataflow.
The Power BI dataflow has the following requirements:
• Be able to create a copy of the dataflow to separate Power Bl workspaces
• Schedule the dataflow to update every day at 11:00 AW. You need to configure the dataflow.
What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Passing Certification Exams Made Easy visit - https://www.2PassEasy.com



Welcome to download the Newest 2passeasy PL-200 dumps
https://www.2passeasy.com/dumps/PL-200/ (211 New Questions)

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 202
- (Exam Topic 3)
A company deploys a chatbot that is embedded in a Power Pages website. The company has the following requirements for the chatbot:
• Azure AD users only must be able to use the chatbot when accessing sensitive data.
• The chatbot must be accessible only from the Power Pages website. You need to recommend a solution that meets the requirements.
Which two options should you recommend? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Enable Manual authentication.
B. Set up a new channel for the chatbot.
C. Enable Only for Teams authentication.
D. Enable web channel security.
E. Configure a data loss prevention policy.

Answer: DE

NEW QUESTION 205
- (Exam Topic 3)
You are configuring Microsoft Dataverse security. You plan to assign users to teams. Record ownership and permissions will differ based on business
requirements.
You need to determine which team types meet the requirements.
Which team type should you use? To answer, drag the appropriate team types to the correct requirements.
Each team type may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
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B. Not Mastered

Answer: A

Explanation: 
Box 1: Microsoft Teams team
Dataverse supports two types of record ownership. Organization owned, and User or Team owned. This is a choice that happens at the time the table is created
and can’t be changed. For security purposes, records that are organization owned, the only access level choices is either the user can do the operation or can’t.
For user and team owned records, the access level choices for most privileges are tiered Organization, Business Unit, Business Unit and Child Business Unit or
only the user’s own records. That means for read privilege on contact, I could set user owned, and the user would only see their own records.
Box 2: Access team
An access team doesn’t own records and doesn’t have security roles assigned to the team. The team members have privileges defined by their individual security
roles and by roles from the teams in which they are members. The records are shared with an access team and the team is granted access rights on the records,
such as Read, Write or Append.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/wp-security-cds
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/use-access-teams-owner-teams-collaborate

NEW QUESTION 210
- (Exam Topic 3)
A company has a custom website.
You need to embed a Power Virtual Agents chatbot into the website. What should you use?

A. Webpage URL
B. Form ID
C. Bot ID
D. IFrame

Answer: D

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/publication-connect-bot-to-web-channels

NEW QUESTION 214
- (Exam Topic 3)
You create functionality for a company. The functionality includes a Microsoft Dataverse table with a form for data entry. The functionality will be distributed to other
lines of business in the company, each with its own Dataverse environment.
New forms must not be created in order for updates to the functionality to work correctly. You need to package the new functionality for distribution.
What should you do?

A. Use a patch solution and disable the ability to create new forms for the table.
B. Use a managed solution and include only the needed form.
C. Use an unmanaged solution and include only the needed form.
D. Use a managed solution and disable the ability to create new forms for the table.

Answer: B

Explanation: 
Managed solutions are used to deploy to any environment that isn't a development environment for that solution. This includes test, UAT, SIT, and production
environments. Managed solutions can be serviced independently from other managed solutions in an environment. As an ALM best practice, managed solutions
should be generated by exporting an unmanaged solution as managed and considered a build artifact. Additionally:
You can't edit components directly within a managed solution.
Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm

NEW QUESTION 215
- (Exam Topic 3)
You are a Dynamics 365 Customer Services administrator. You have a Production instance and Sandbox instance.
Users record Production instance data in the Sandbox instance.
You need to ensure that the users only record data in the Production instance.
Which security function needs to be edited to prevent access to the Sandbox? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/control-user-access

NEW QUESTION 216
- (Exam Topic 3)
You create a Power Platform help Desk solution.
You need to create a dashboard that displays information on help desk cases that are handled each week. Which dashboard components should you use? To
answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Area chart Box 2: System chart
System charts are organization-owned charts, which makes them available to anyone with access to read the data running the app. System charts can't be
assigned or shared with specific app users.
Box 3: Personal dashboard Box 4: Personal dashboard Box 5: Area chart
Reference:
https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-
system-chart
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NEW QUESTION 218
- (Exam Topic 3)
You create a new solution for a business process.
The business process includes uploading specific file types to a web service.
You need to ensure that the business process works the same way anywhere the solution is deployed. Which option should you use? To answer, drag the
appropriate options to the correct configurations. Each
option may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Solution system settings
For Power Apps in Settings > Customizations > Customize the System you can configure email and document management, activate or deactivate processes, and
more.
Box 2: Environment variable
When should Environment variables be used? Some examples include:
When an input parameter needs to change across environments and should not be hard-coded. For example, a URL that points to a different resource in
development and production environments.
If you’re building a solution where your customer is required to provide an input value. Application setup pages.
Incorrect:
A connection reference is a solution component that contains information about a connector. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/advanced-navigation https://powerapps.microsoft.com/en-us/blog/environment-variables-
available-in-preview/

NEW QUESTION 223
- (Exam Topic 3)
A company creates a Microsoft Teams app that stores data in two tables in a Microsoft Dataverse for Teams environment.
Users require access to the app and the app data. You need to configure access.
What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 226
- (Exam Topic 3)
A farm uses a canvas app to manage schedules for planting fields with crop seeds. The farm uses business intelligence to provide recommendations for schedule
changes based on weather data.
You must implement a business rule that changes information for several forms in the canvas app based on business intelligence data.
You need to configure the business rule. Which scope should you use?

A. Table
B. All Forms
C. Form specific

Answer: A

NEW QUESTION 231
- (Exam Topic 3)
You are embedding a Power Apps visual in a Power BI dashboard. External customers must authenticate to have access to the dashboard. You need to configure
the solution.
Which two actions should you perform? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Set the Power Bl service to authenticate users.
B. Use a table in the Power Bl dashboard.
C. Publish to Power Bl Report Server.
D. Set the Power Bl service to allow anonymous access.
E. Share the Power Apps visual components with external users.

Answer: AE

Explanation: 
Power BI uses Azure Active Directory (AAD) to authenticate users who sign in to the Power BI service, and in turn, uses the Power BI login credentials whenever a
user attempts to access resources that require authentication. Users sign in to the Power BI service using the email address used to establish their Power BI
account; Power BI uses that login email as the effective username, which is passed to resources whenever a user attempts to connect to data. The effective
username is then mapped to a User Principal Name (UPN) and resolved to the associated Windows domain account, against which authentication is applied.
Reference: https://docs.microsoft.com/en-us/power-bi/enterprise/service-admin-power-bi-security

NEW QUESTION 234
- (Exam Topic 3)
A company creates a bot by using Power Virtual Agents.
The company requires the bot to transfer callers to an agent if the bot is unable to recognize a customers request.
You need to configure the bot for the unrecognized information from the customer. Which feature should you use?

A. Fallback workstream
B. Fallback topic
C. Fallback skill
D. Fallback queue
E. Fallback entity

Answer: B

Explanation: 
A Fallback topic is a type of topic in Power Virtual Agents that is used when the bot is unable to understand the customer's request. When a Fallback topic is
triggered, it takes over the conversation and presents the customer with a set of options or a message that allows them to get the help they need. This can include
options such as requesting to speak with an agent, providing feedback, or getting more information about the bot's capabilities. Fallback topic can be configured to
automatically transfer the customer to an agent.
References:

 https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/fallback

 https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/bot-topics

NEW QUESTION 235
- (Exam Topic 3)
You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.
The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable server-based SharePoint integration.
Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation: 
 References:
https://docs.microsoft.com/en-us/power-platform/admin/set-up-dynamics-365-online-to-use-sharepoint-online

NEW QUESTION 239
- (Exam Topic 3)
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The business team provides the following list of features that they would like you to implement:
• Group by or sort columns in the current view.
• Configure a business rule to show an error message.
• Edit values in calculated fields.
• Edit the Address composite field.
• Use the editable grid on mobile phones.
Which actions can you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 241
- (Exam Topic 3)
You have a business process flow (BPF) that interacts with the Account entity. You configure a new version for the BPF and add a new stage at the beginning.
You need to identify the impact of the new version on the existing account records.
What is the outcome in each scenario? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text Description automatically generated
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Box 1: Existing accounts show the new BPF.
When an entity record is being created and if there are multiple BPFs defined on that entity. The system would do the following:
If the ProcessId field is set to Guid.Empty. The system will skip defaulting the BPF on that instance.
If the ProcessId field is set to specific BPF entity reference. The system will default to the specified BPF. If the ProcessId field on the record is not set. The system
will default the BPF.
Box 2: No BPF is linked to a new account.
Note: A business process flow definition is represented as a custom entity and an instance of a process is stored as a record within that entity. Each record is
associated with a data record (such as an Account, Contact, Lead, or Opportunity) and in case of cross-entity processes, with a data record for each participating
entity.
Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/business-process-fl

NEW QUESTION 246
- (Exam Topic 3)
You create a canvas app for a sales team. The app has an embedded Power BI tile that shows year-to-date sales. Sales users do not have access to the data
source that the tile uses.
Sales team users must be able to see data in the Power BI tile. You must minimize the level of permissions that you grant and minimize administrative overhead.
You need to share another Power BI component to make the data visible. What should you share?

A. The Power Bl dataset the tile uses as a data source.
B. The Power Bl workspace that includes the tile.
C. The Power Bl dashboard that includes the tile.

Answer: C

Explanation: 
Once shared, the PowerApps app will be accessible by all users who have permissions to access the app. However, in order to make the Power BI content visible
to those users, the dashboard where the tile comes from needs to be shared with the user on Power BI. This ensures that Power BI sharing permissions are
respected when Power BI content is accessed in an app.
Reference:
https://powerapps.microsoft.com/en-us/blog/power-bi-tile-in-powerapps/

NEW QUESTION 247
- (Exam Topic 3)
A company creates a canvas app.
The app requires near real-time data from an accounting system that resides in a customers data center. You need to implement a solution for the app.
What should you create?

A. Azure DevOps pipeline
B. On-premises data gateway
C. Power Pages
D. Data integration project

Answer: B

Explanation: 
When a company creates a canvas app that requires near real-time data from an accounting system that resides in a customer's data center, one solution that can
be implemented is to create an On-premises data gateway.
An On-premises data gateway is a service that allows Power Apps to connect to and access data sources that are located on-premises, such as the accounting
system in the customer's data center. The gateway acts as a bridge between the cloud-based Power Apps and the on-premises data sources, enabling real-time
data transfer and integration.
References:

 https://docs.microsoft.com/en-us/power-platform/admin/gateway-reference

 https://docs.microsoft.com/en-us/power-platform/admin/gateway-onprem

 https://docs.microsoft.com/en-us/power-platform/admin/real-time-data-integration

NEW QUESTION 251
- (Exam Topic 3)
You create and publish a Power Bl report that contains an embedded canvas app. The report will be used by multiple people.
The canvas app has an issue that must be corrected. You update the canvas app.
You need to ensure that the updated canvas app is available in the published Power Bl report. What should you do?

A. Publish the Power Bl report from Power Bl Desktop.
B. Manually refresh the data source on the published Power Bl report.
C. Publish the Power Bl report from Power Bl Desktop and reshare to any users.
D. Publish the canvas app.

Answer: B

Explanation: 

 If you change the data fields associated with the visual, you must edit the app from within the Power BI service by selecting the ellipsis (...) and then selecting
Edit. Otherwise, the changes won't be propagated to Power Apps, and the app will behave in unexpected ways.

 The Power Apps visual can't trigger a refresh of Power BI reports and Power BI data sources from within Power BI Desktop. If you write back data from the app
to the same data source as the report, your changes won't be reflected immediately in Power BI Desktop. Changes are reflected on the next scheduled refresh.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/powerapps-custom-visual#limitations-of-the-po
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NEW QUESTION 252
- (Exam Topic 3)
A company is developing several Power Virtual Agents chatbots. The company manufactures more than 1,000 different products.
The chatbots must prompt users to enter or select a product.
You need to store the model information so that it can be reused across all chatbots. Where should you store the model data?

A. Global variables
B. Custom entities
C. Topics
D. Multiple choice options

Answer: A

NEW QUESTION 253
- (Exam Topic 3)
A company uses a model driven app.
The company needs to automatically update the Status column in real time. You need to configure this feature.
Solution: Create a flow that has an Update a row action. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 258
- (Exam Topic 3)
A company has a model-driven app.
The app must meet the following requirements:
• Prevent users from saving a record if validation from a custom action fails.
• Query and update a list of records.
You need to configure processes for the app without using code.
Which processes should you use? To answer, drag the appropriate processes to the correct requirements. Each process may be used once, more than once, or
not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 263
- (Exam Topic 3)
A company uses Common Data Service to manage prospects. The company has a business process flow named BPFA that is associated with the Prospect entity
to streamline the prospect management process.
You add a field named Category to the Prospect entity. You create additional business process flows. You apply the business process flows to Prospect records
based on the selected category. Users can switch to any other newly configured business process flows but must not use BPFA.
You need to configure the solution.
What are two possible ways to achieve this goal? Each correct answer presents a complete solution. NOTE Each correct selection is worth one point.

A. Remove all of the privileges for BPFA.
B. Deactivate BPFA.
C. Use a business rule to prevent users from switching to BPFA.
D. Change the display order of the business process flows to move BPFA to the bottom of the list.

Answer: AB

NEW QUESTION 266
- (Exam Topic 3)
You are setting up Power Apps security for a company. The company has a CEO, two vice presidents, and 10 managers. Five support representatives report to
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each manager.
You set up Manager Hierarchy so managers are able to view data only for the representatives who report to them. The CEO must be able to view all data for
everyone. All support representatives must be able to view customer information in each other’s data across all managers.
You need to resolve issues that arise during testing.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Move the manager and reports to a separate business unit.
Keep the Manager hierarchy, and put the reports to the appropriate business unit.
Note: Two security models can be used for hierarchies, the Manager hierarchy and the Position hierarchy. With the Manager hierarchy, a manager must be within
the same business unit as the report, or in the parent business unit of the report’s business unit, to have access to the report’s data. The Position hierarchy allows
data access across business units. If you are a financial organization, you may prefer the Manager hierarchy model, to prevent managers’ accessing data outside
of their business units. However, if you are a part of a customer service organization and want the managers to access service cases handled in different business
units, the Position hierarchy may work better for you.
Box 2: Add the CEO to the representative user record as a manager. Set up Manager and Position hierarchies
The Manager hierarchy is easily created by using the manager relationship on the system user record. You use the Manager (ParentsystemuserID) lookup field to
specify the manager of the user.
Note: Depth is used to limit how many levels deep a manager has Read-only access to the data of their reports. For example, if the depth is set to 2, the CEO can
see the data of the VP of Sales, VP of Service and Sales and Service Managers. However, the CEO doesn’t see the Sales data or the Support data.

Box 3: Add users to field security
Power Platform's field-level security lets you set which fields users can see or edit. Reference: https://docs.microsoft.com/en-us/power-platform/admin/hierarchy-
security https://docs.microsoft.com/en-us/power-platform/admin/field-level-security

NEW QUESTION 269
- (Exam Topic 3)
A company is implementing a data model by using Dataverse.
The company requires the following columns in a new custom table:
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You need to choose the column type that uses the least amount of database storage for each column.
Which column types should you choose? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 273
- (Exam Topic 3)
A company plans to implement AI Builder to add intelligence to several business processes. Each business process uses different sources and produces different
outputs.
You need to determine which AI Builder model types to use.
Which model types should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/ai-builder/form-processing-model-overview https://docs.microsoft.com/en-us/ai-builder/entity-extraction-overview

NEW QUESTION 274
- (Exam Topic 3)
A company’s sales staff wants a simplified way to manage their opportunities in Dynamics 365 Sales without adding custom code.
You need to provide a solution for each requirement.
Which solutions should you provide? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated
Box 1: Add a Kanban control.
The Kanban view allows your sales team to move opportunities from one stage to another by simply dragging them.
Box 2: Add both controls to the My Opportunities view.

 Kanban views help salespeople to manage their opportunities and activities effectively. Add the Kanban control to the Opportunity and Activity entity so
salespeople can use the Kanban views.The Kanban control works only on the Opportunity and Activity entities.

 If you use unified interface, you can display any record in a calendar view via the calendar control.
- Go to Settings->Customization->Customize the System
- Open the configuration for the entity that you want to use the calendar control (Opportunities in our example)
- Click the View tab
- Click “Add Control” and select the calendar control.
- Click the dot for every interface from which you want the calendar control to be available.
Box 3: Use a List view
opportunities in Dynamics 365 Sales
Reference:
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave1/dynamics365-sales/work-opportunities- https://crmtipoftheday.com/1206/view-any-
dynamics-365-record-on-a-calendar/
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https://fivep.com.au/how-to-get-visibility-and-report-on-an-opportunities-active-current-sales-stage-without-cod

NEW QUESTION 276
- (Exam Topic 3)
You create a JavaScript web resource named MyBusinessLogic. The code it contains uses functionality from a third-party JavaScript library.
You notice that an independent software vendor (ISV) solution uses the same third-party library in their managed solution.
You plan to deploy your solution to other environments by using a managed solution. The ISV solution might not be installed in the other environments.
You need to package the solution for deployment
What are two ways to achieve this goal? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Create a new JavaScript web resource by using the code from the third-party librar
B. Add the new JavaScript web resource along with MyBusinessLogic to the solution.
C. Add a copy of the JavaScript library from the ISV to the solution along with MyBusinessLogic.
D. Add the code from the third-party JavaScript library to MyBusinessLogi
E. Add MyBusinessLogic to the solution.
F. Add only the third-party JavaScript web resource to the solution.

Answer: AC

Explanation: 
Web resources in model-driven apps.
Web resources are virtual files that are stored in the Microsoft Dataverse database and that you can retrieve by using a unique URL address.
Capabilities of web resources.
Web resources represent files that can be used to extend the Dataverse web application such as html files, JavaScript, and CSS, and several image formats.
Reference: https://docs.microsoft.com/en-us/power-apps/developer/model-driven-apps/web-resources

NEW QUESTION 281
- (Exam Topic 3)
A company is implementing Power Apps and Power Automate.
Several components are created within Power Apps. Microsoft Dataverse. and Power Automate. These components must be promoted from the development
environment to the user acceptance test environment in a single solution package.
You need to create the solution package for promotion. Where should you create the package?

A. Office 365 admin center
B. Azure DevOps
C. Power Apps designer
D. Microsoft Power Platform admin center
E. Azure portal

Answer: D

Explanation: 
A solution package is a bundle of components, such as Power Apps, Power Automate, and Microsoft Dataverse, that can be promoted from one environment to
another. To create the solution package for promotion in a company that is implementing Power Apps and Power Automate, the package should be created in the
Microsoft Power Platform admin center.
In the Power Platform admin center, you can create a solution package that includes the necessary components and export it as a .zip file. This file can then be
imported into the desired environment, such as the user acceptance test environment, to promote the components.
References:

 https://docs.microsoft.com/en-us/power-platform/admin/solutions/create-solution

 https://docs.microsoft.com/en-us/power-platform/admin/solutions/import-solution

 https://docs.microsoft.com/en-us/power-platform/admin/solutions/export-solution

NEW QUESTION 282
- (Exam Topic 3)
You manage the Dynamics 365 environment for a company.
You need to ensure that there are no leads for a customer before you create a new opportunity for the customer.
How can you use duplicate detection rules to achieve this goal? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 286
- (Exam Topic 3)
You are a Dynamics 365 Customer Service administrator.
A user must be able to view system posts and activities in a dashboard. You need to create the dashboard for the user.
Which components should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Timeline
The timeline helps agents see all customer interaction history across channels, personnel, and the support lifecycle. The timeline is used across Dynamics 365
applications to capture activities like notes, appointments, emails, tasks, and more, to ensure that all interactions with the customer are tracked and visible over
time. Agents use the timeline to quickly catch up on all of the latest activity details with the customer to provide the most personalized support experience.
Box 2: Lists Reference:
https://docs.microsoft.com/en-us/dynamics365/customer-service/customer-service-hub-user-guide-timeline-adm
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